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Dasar
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Agenda

1. Membuat dokumen

2. Melakukan editing sederhana atas kolom dan baris

3. Mencetak dokumen
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Pendahuluan
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Tentang Perangkat Lunak Lembar Sebar 
(Spreadsheet)

4

Perangkat lunak lembar sebar (spreadsheet) adalah sebuah program yang 
berfungsi untuk mengolah data berupa angka maupun teks yang berada 
dalam bentuk kolom dan baris. 

Beberapa perangkat lunak lembar sebar (spreadsheet):

1. Microsoft Excel

2. Google Spreadsheet

3. StarOffice CALC

4. KSpread



Dalam pembelajaran ini kita menggunakan Microsoft Excel versi 2013
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Sumber gambar: https://vemafats.com/kerugian-menggunakan-microsoft-excel-sebagai-aplikasi-pencatatan/

https://vemafats.com/kerugian-menggunakan-microsoft-excel-sebagai-aplikasi-pencatatan/
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Membuka aplikasi 
Microsoft Excel 2013



Menggunakan search windows

1. Gunakan shortcut keyboard Windows + S (    +     ) untuk menampilkan search box

2. Ketik “Excel” pada search box lalu klik Enter
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Meng-klik Shortcut Microsoft Excel di Desktop
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Lembar kerja Excel

Exit button

Maximize button

Minimize button
Nama dokumen

Nama cell

Cell yang aktif

Tab lembar kerja

Indikator baris

Indikator kolom

Indikator rumus/
formula

Tab menu

Scrolling bar
Kanan-kiri

Scrolling bar
atas-bawah

Tombol quick access

Tampilan di Microsoft Excel
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Membuat File Baru di 
Microsoft Excel 2013



Langkah-langkah
1. Untuk membuat file baru pilih menu 

File – New – Blank Workbook
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2. Untuk membuka file yang sudah 
tersimpan pilih menu File – Open – 
Pilih lokasi tempat menyimpan file - 
Setelah terlihat tampilan 
dialog Open, pilih folder direktori 
penyimpanan, kemudian pilih nama 
file
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Menambah Data ke 
Dalam Dokumen



Langkah-langkah
1. Pilih dan aktifkan cell dimana data akan dimasukkan

2. Ketik data yang akan diinputkan (data bisa berupa angka maupun teks)

3. Tekan Enter untuk konfirmasi input data

4. Input data ini juga bisa dilakukan dengan mengetikkan langsung di formula bar
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Contoh input data nomor, 
nama lengkap dan nilai matematika
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Menu dan Shortcut 
dalam Microsoft Excel 

2013



Dalam Microsoft Excel terdapat beberapa Menu yakni:

 Home

 Insert

 Page Layout

 Formulas

 Data

 Review

 View
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HOME

Menempelkan data pada cell tertentu

Eksekusi data dengan menghilangkan data aslinya.

Menduplikasi data.

Jenis huruf

Ukuran huruf

Membesarkan huruf

Mengecilkan huruf

Mengatur posisi teks

Menentukan letak teks sesuai ukuran cell

Mengatur format jenis data yang ada di cell

Memvisualisasikan data yang ada di cell

Memformat cell sebagai tabel

Mengklasifikasi cell dengan warna

Menambah, menghapus &memformat cell

Melakukan sortir & filter cell

Menjumlahkan data di cell

Menambah/mengurangi jumlah digit

Tampilkan angka desimal sebagai angka bulat.

Menjadikan persentase

Atur format harga sesuai spesifikasi mata uang

Memberi warna pada cell dan huruf

Menebalkan garis pada cell/tabel

Style huruf

Menemukan cell tertentu



Shortcut di menu Home
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Icon Fungsi Shortcut

Cut mengeksekusi data dengan menghilangkan data aslinya. CTRL+X

Copy Menduplikasi data tanpa menghilangkan data aslinya. CTRL + C

Paste Menempelkan data pada cell tertentu CTRL + V

Bold Menebalkan huruf CTRL + B

Italic Memiringkan huruf CTRL + I

Underline Memberi garis bawahpada huruf CTRL + U

Percentage Menjadikan format  persentase  untuk  sel  yang dipilih CTRL+SHIFT+%). 
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INSERT

Membuat tabel dan membuat tabulasi data dari tabel

Menambahkan gambar/bentuk

Insert diagram hierarkis berdasar data

Menangkap tampilan layar

Menampilkan data numerik
 dalam macam diagram

Menampilkan data numerik
 dalam macam grafik

Menyisipkan bentuk 
rumus dan simbolmenyisipkan objek tertentu dalam lembar kerja yang aktif.

menambahkan  tanda  tangan  digital

menampilkan  fasilitas  di  Wordart

mengatur tanggal, jam, nomor, halaman, judul halaman, dst

Membuat  link  ke  halaman  web,  gambar, 
 alamat  e-mail,  atau  program

menulis dalam kotak dari table



Shortcut di menu Insert
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Icon Fungsi Shortcut

Table Menambahkan tabel CTRL + T

Hyperlink Menambahkan tautan link CTRL + K
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PAGE LAYOUT

Mengubah  desain  keseluruhan  dari  seluruh  dokumen, 
termasuk  warna,  font  (tulisan),  dan  efek

mengatur batas  teks di halaman dokumen

mengatur posisi & size kertas

menandai area spesifik saat dicetak

memilih gambar latar

menentukan baris dan kolom untuk diulang di tiap halaman

mengecilkan lebar output lembar kerja yang akan dicetak 

menunjukkan garis antara baris dan 
kolom untuk memudahkan edit 
sebelum dicetak

Mengedit gambar/objek ke layer 
depan/belakang

Merotasi objek

Menyatukan objek
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FORMULAS

Membuka kotak dialog rumus

kumpulan  formula  yang  sering  digunakan

kumpulan formula  yang  baru saja digunakan.

kumpulan formula yang berhubungan dengan keuangan.

kumpulan formula yang berhubungan dengan logika.

kumpulan formula yang berhubungan pengolahan kata

kumpulan formula  yang  berhubungan dengan  tanggal/waktu

kumpulan formula  yang menggunakan referensi pada tabelnya

kumpulan formula yang berhubungan dengan matematika dan  trigonometri.
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DATA

mengelompokkan beberapa sel berdasarkan baris atau kolom.

Mengambil data eksternal (dari Ms. Access, Web, dll

melakukan penyaringan dan pengurutan data

melakukan koneksi pengambilan data dari luar

melakukan pengecekan dan pengaturan data
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REVIEW

mengecek  lafal atau ejaan kata

mencari bahan referensi

menyarankan kata lain dengan arti yang mirip 

menerjemahkan teks 

memberikan komentar 

melindungi sebuah sheet dengan password 

membatasi  akses  ke  buku  kerja 

memungkinkan  beberapa  orang  dapat  bekerja  dalam  sebuah workbook pada 
saat yang sama

melacak semua perubahan yang dibuat di dokumen

memungkinkan orang-orang tertentu dapat mengedit sel 
yang terseleksi dalam buku kerja atau lembaran yang 
dilindungi
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VIEW

mengatur tampilan worksheet dan workbook.

menampakkan  dan  menyembunyikan  tool  pada  tampilan  worksheet  dan workbook

memperbesar dan memperkecil tampilan

mengatur tampilan window worksheet dan workbook.
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Fitur-fitur Pengelolaan 
Spreadsheet



Membuat Worksheet / Spreadsheet / Sheet Baru
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1. Home > ribbon Cells > Insert > Insert Sheet.

2. Klik di pojok kiri bawah sebelah kanan teks sheet atau klik kanan lalu pilih 
Insert.
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2. Menyimpan Workbook Baru (SAVE)
Klik Office Button > Save, atau CTRL + S

3. Membuka File Workbook yang Sudah Ada

Klik Office Button > Open, atau  CTRL + O  

4. Menyimpan Workbook Dengan Nama Baru (Save As)

Klik Office Button >  Save As, atau dengan Ctrl + F12

5. Menyimpan Workbook Dengan Berbagai Format

Klik Office Button  > Save As > pilih lokasi penyimpanan >

Save as type (pilih format-nya) >Save 
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Melakukan Editing 
Sederhana



Memformat huruf (font)
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Huruf dapat diedit sesuai kebutuhan 
melalui shortcut menu Font, atau lebih 
detail dapat mengklik tombol panah 
pada menu Font atau (Ctrl + Shift + F)



Alignment (Perataan)
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Untuk mengatur perataan isi sel, dapat 
dilakukan melalui shortcut menu Alignment, 
atau lebih detail dapat mengklik tombol panah 
pada menu Alignment.



Lanjutan …
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1.Text Alignment
✓Horizontal

a. General: perataan teks secara normal (default)
b. Left: rata kiri
c. Center: rata tengah
d. Right: rata kanan
e. Fill: menampilkan isi sel yang disesuaikan dengan lebar sel (jika isi sel lebih 

panjang dari lebar sel,  maka karakter yang melebihi lebar sel akan 
disembunyikan).

f. Justify: meratakan data sesuai dengan lebar kolom
g. Center across Selection: perataan teks secara tengah tanpa melakukan  

penggabungan (merge) beberapa sell.
h. Distributed: Isi sel didistribusikan ke seluruh lebar sel, jika isi sel melebihi lebar 

sel normal, maka sel akan otomatis melebar menyesuaikan isi sel.



Lanjutan …
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✓ Vertical

a. Top:  isi sel akan ditempatkan di bagian atas sel

b. Center: isi sel akan akan ditempatkan dibagian tengah sel

c. Bottom (default): isi sel akan ditempatkan pada bagian bawah sel.

d. Justify:  teks tersebar merata di seluruh sel, dan tinggi baris disesuaikan 
sehingga isi sel yang memiliki panjang lebih dari lebar sel akan ditampilkan 
dalam satu sel. Lebar kolom tidak terpengaruh sama sekali.

e. Distributed: untuk meratakan isi sel antara bagian atas dan bagian bawah 
sel. 



Lanjutan …
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2.Text Control
 Wrap text: membuat sel mengikuti panjang dari isi sel.

 Shrink To Fit: ukuran font akan disesuaikan dengan lebar sel.

 Merge cells: menggabungkan dua atau lebih sel yang telah dipilih untuk 
menjadi satu sel

3.Orientation: Untuk mengubah orientasi atau posisi teks dalam sel



Format data (text, date, number) 
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Untuk mengatur jenis data, dapat dilakukan 
melalui shortcut menu Number, atau lebih 
detail dapat mengklik tombol panah pada
menu Number.



Lanjutan …
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Beberapa jenis data yang biasa digunakan diantaranya:

1. Text: merupakan format data yang berbentuk teks, yang mencakup huruf, karakter 
non numerik serta kombinasi huruf dan angka.

2. Date: merupakan format data berbentuk tanggal, ada beberapa format penulisan  
yang akan secara otomatis terdeteksi. Keterangan format penulisan, "dd" mewakili 
tanggal, "mm" mewakili bulan dan "yyyy" mewakili tahun.

3. Number: Format number antara lain bilangan bulat serta bilangan pecahan atau 
desimal. 

4. Currency: merupakan format penulisan number dengan mata uang. 
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Fitur-fitur kolom  
dan baris



Kolom
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✓ Ada 3 cara mengatur lebar kolom:
1. Sorot kolom yang akan di atur 

lebarnya, misal kolom A, B dan 
C, kemudian klik menu Cells > 
Format > Column Width, atau

2. Pada huruf-huruf nama kolom 
di-klik kanan > Column Width, 
atau

3. Posisikan pointer pada garis 
pemisah kolom yang tersorot, 
lalu geser.

✓ Untuk menyisipkan kolom maka 
dipilih Insert.



Baris
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✓ Cara mengatur tinggi baris:
1. Sorot baris yang akan diatur 

tingginya, misal baris 3, 4, dan 
5, kemudian klik menu Cells > 
Format > Row Height, atau

2. Pada angka-angka nomor baris 
di-klik kanan > Row Height, 
atau

3. Posisikan pointer pada garis 
pemisah baris yang tersorot, 
lalu geser ke bawah.

✓ Untuk menyisipkan baris, pada 
angka baris di-klik kanan > Insert 



Garis
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✓ Border

Merupakan garis berbentuk vertikal, horizontal atau 
berupa bingkai di sekeliling sel atau range. Cara:

- Blok tabel yang akan diberi bingkai > klik kanan > 
Format Cells > pilih tab Border

- Bisa juga menggunakan shortcut border di menu 
Font.

- Style:  membuat model garis.

- Presets: menentukan jenis bingkai yang 
diinginkan, terdapat tiga pilihan  antara lain: 
None, Outline dan Inside.



Lanjutan …
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✓ Arsiran atau shading

Cara membuat: 

 Blok sel yang akan diberi arsiran misal pada 
judul tabel > klik kanan Format Cells > tab Fill 

 Pilih warna "Background“ > tentukan Pattern 
Style atau arsiran yang akan dipakai.

 Bisa juga menggunakan shortcut Fill Color di 
menu Font.
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Fitur-fitur Copy-
Cut-Paste



Copy-Cut-Paste Sel

42

1. Blok sel yang akan disalin 

2. Copy – Paste : Klik menu Home > Copy atau 
ctrl+c atau klik kanan pilih copy > pilih sel 
tempat data salinan diletakkan > klik Paste 
pada menu Home atau ctrl+v atau klik kanan 
pilih paste

3. Cut – Paste : Klik menu Home > Cut atau ctrl+x 
atau klik kanan pilih cut > pilih sel tempat data 
salinan diletakkan > klik Paste pada menu 
Home atau ctrl+v atau klik kanan pilih paste



Move-Copy Sheet (Lembar Kerja)
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Cara untuk menyalin Sheet (lembar 
kerja):
 Klik kanan pada Sheet yang akan 

disalin
 Pilih Move or Copy
 Check list Create a copy
 Ok 
Cara untuk memindahkan Sheet 
(lembar kerja):
 Klik kanan pada Sheet yang akan 

disalin
 Pilih Move or Copy
 Pilih lokasi pemindahan
 Ok 

Pilihan lokasi 
pemindahan

Check list jika ingin 
membuat salinan
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Formula sederhana



Menambahkan Fungsi Aritmatika Dasar
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Menambahkan Fungsi Matematika
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o SUM: menjumlahkan isi range sel

=SUM(<range data>)

o ABS: mengubah  bilangan  negatif  ke  
positif  atau  sebaliknya

=ABS(number)

o INT:  membulatkan angka ke bawah ke 
bilangan bulat terdekat

=INT(number)

o ROUND: membulatkan angka sebanyak 
desimal yang diinginkan

=ROUND(number;num_digit)

=SUM(A3:A8)

=ABS(A3)

=INT(A6)

=ROUND(A11; 2)



Menambahkan Fungsi Statistik
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o Max: mencari nilai maksimum dari  range sel

=MAX(<range data>)

o Min: mencari nilai maksimum dari  range sel

=MIN(<range data>)

o Average: mencari nilai  rata-rata dari  range sel

=AVERAGE(<range data>)

o Count: menghitung  jumlah data dari suatu  
range sel

=COUNT<range data>)

=MAX(A3:A8)

=MIN(A3:A8)

=AVERAGE(A3:A8)

=COUNT(A3:A8)



Menambahkan Fungsi Logika
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o If: menentukan nilai dengan membandingkan yang didasarkan pada kondisi  tertentu

=IF(logical_test;value_if_true;value_if_false)

=IF(A3>75;"Lulus";"Remedial")

=IF(A3>80;"A";IF(A3>70;"B";"C"))

If Tunggal

If Majemuk



Lanjutan …
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o And: menentukan nilai kebenaran dengan argumen atau kondisi yang kedua-duanya 
harus  terpenuhi  (bernilai benar)

=AND(logical1;logical2; …)

o Or: menentukan nilai kebenaran dengan argumen atau kondisi yang salah satu atau 
keduanya harus  terpenuhi  (bernilai benar)

=OR(logical1;logical2; …) =AND(A4>75;B4="A")

=OR(A4>75;B4="A")



Menambahkan Fungsi Lookup
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o Vlookup: menentukan suatu nilai tertentu berdasarkan kondisi di mana data diambil 
dari tabel sumber secara vertical

=VLOOKUP(lookup_value;table_array;col_index_num)

o Hlookup: menentukan suatu nilai tertentu berdasarkan kondisi di mana data diambil 
dari tabel sumber secara horizontal

=HLOOKUP(lookup_value;table_array;row_index_num)

=VLOOKUP(B2;$A$10:$B$13;2;FALSE)

=HLOOKUP(B2;$E$9:$H$10;2;FALSE)



Rumus (formula) yang salah (error) dapat 
diperbaiki:

51

 #####

Excel menampilkan error ini ketika lebar kolom tidak cukup untuk menampilkan isi 
dari cell atau cell mengandung format tanggal/waktu yang menghasilkan nilai negatif. 
Untuk mengatasinya Anda dapat menambah lebar kolom atau mengganti format 
tanggal/waktu sehingga menghasilkan nilai yang benar.

 #DIV/0!

Excel menampilkan error ini ketika pada formula yang Anda buat terdapat pembagian 
dengan 0 (nol) atau dengan cell yang tidak bernilai (kosong). Pada Excel nilai 0 atau 
cell kosong tidak dapat digunakan untuk membagi dalam sebuah formula.

 #NAME?

Excel menampilkan error ini ketika Excel tidak dapat mengenali sebuah nama yang
digunakan pada formula. Contohnya, nama range pada formula yang terhapus, salah 
mengetikkan fungsi, teks pada formula tidak diapit tanda kutip (“), atau tidak
menyertakan tanda titik dua ( : ) pada alamat range.



Lanjutan …
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 #NULL!

Excel menampilkan error ini ketika Anda menggunakan Intersection 
Operator pada dua range yang berhubungan pada sebuah formula.

 #NUM!

Excel menampilkan error ini ketika dalam sebuah formula atau 
fungsi terdapat kesalahan penggunaan bilangan.

 #REF!

Excel menampilkan error ini ketika mengacu pada referensi cell 
atau range yang salah. Contohnya, Anda telah menghapus cell yang 
diacu oleh formula atau Anda telah menyalin cell yang Anda 
pindahkan ke atas cell yang mana diacu oleh formula.



Lanjutan …
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 #VALUE!

Excel menampilkan error ini ketika formula yang Anda buat 
mengandung cell yang berisi tipe data yang berbeda. Contohnya, 
jika Anda membuat formula =DAY(C6), padahal tipe data pada C6 
adalah teks, maka akan muncul pesan error #VALUE!.

 #N/A

Excel menampilkan error ini ketika nilai cell not available untuk 
fungsi atau formula. Biasanya ini terjadi pada fungsi LOOKUP yang 
mana cell berisi nilai yang tidak terdapat dalam tabel LOOKUP atau 
data pada tabel LOOKUP tidak mengurut secara alphabet.



54

Mencetak Dokumen 
Lembar Sebar 

(Spredsheet)



Menentukan Bagian yang Ingin Dicetak
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 Sebelum mencetak dokumen, kita perlu mengatur halaman melalui 
ribbon Page Layout > menu Page Setup. 



Lanjutan …
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 Atur Margin, Orientation (Arah data terhadap kertas), Size (Ukuran 
kertas), Print Area (digunakan untuk mencetak range sel tertentu) 

 Set Print Titles untuk mengatur Page, Margins, Header/Footer serta 
mengatur baris yang akan dicetak berulang-ulang.

 Apabila halaman yang akan di cetak sudah diatur, selanjutnya klik File 
> Print > Pilih Printer > masukkan Pages > Copies > Print



Kesimpulan
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Kesimpulan

 Membuat dokumen pengolahan data menjadi lebih mudah dengan aplikasi 
spreadsheet 

 Menu-menu di Microsoft Excel dapat digunakan untuk menginput data, 
mengedit data, memvisualisasikan data

 Fitur editing berfungsi untuk menata dokumen agar lebih menarik dan rapi 

 Formula sederhana mempermudah perhitungan data yang jumlahnya 
banyak. 

 Mencetak dokumen dalam aplikasi spreadsheet dapat disesuaikan dengan 
kebutuhan. 
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Aplikasi
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Latihan

60

 Membuat dokumen dalam Microsoft Excel sampai mencetaknya 
menggunakan rumusan VLOOKUP dan HLOOKUP



Evaluasi
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Tugas Tambahan

62



Tugas Tambahan

63

 Lakukan mini riset untuk membandingkan fitur maupun fungsi 
aplikasi-aplikasi spreadsheet yang kamu ketahui.

 Carilah minimal 5 fungsi editing teks dan formula dalam microsoft 
excel selain yang telah dipelajari. Buat dalam bentuk tabel. 

 Tugas diupload di Google Drive
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